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Introduction
Wintel is a full featured communication software that connects you to other 
computers. 
Following features are included:

* Phonebook which stores your remote service names, phone numbers and 
communication settings.
* File transfer using ASCII, xmodem, xmodem 1k, ymodem batch and 
zmodem protocols.
* A realtime and an offline GIF/JPEG viewer.
* DEC VT100, VT52, ANSI Color, TTY and a raw mode terminal emulations.
* Redialing and sequential dialing capability.
* Programmable script language which automates your logins to remote 
system.
* Chat mode, which lets you chat with the user at the remote end.
* Resizeable fonts, scroll back buffer,    printing log file and session capture.
* uuencode and uudecode internet files.
* Run multiple instances of this application.



Connecting to Remote Computer 
Open phonebook by selecting phonebook command from the File menu. Your 
login session is started by either double clicking an existing entry or by 
selecting an existing entry in the name listbox and then clicking on the dial 
button. A dial window would open up showing you the phone number dialed. 
You can cancel the dial operation by clicking on the Cancel button. The 
system will inform you once the connection has been established.    

Related topics:

Adding a new entry
Phonebook summary
Opening Communication Port



Adding a New Entry to the Phonebook

To add a new entry to the phonebook, open the phonebook by selecting 
phonebook command from the file menu. Click on the New button in the 
phonebook. A Communication setting window would open up. You must 
already know your required settings for the remote computer with which you 
want to communicate. Most services publish their communication settings 
as: 2400,8,N,1. This indicates a 2400 baud modem speed, 8 data bits, no 
parity and 1 stop bit. If you do not know the port where modem is connected 
then click on the default setting button. This program will figure out the port 
and make following settings for you:

Baudrate
2400
Databits
8
Parity
None
Stopbit
1
Flow Control
Xon/Xoff
Phonetype
Tone
Port
Port where your modem is connected.
Terminal
VT100 (Ansi Color)
File transfer Protocol
ZMODEM
Modem
Hayes compatible
Retry dial count
5
Connect timeout
60

You only make entries to the online service name and its phone number.

Related topics:

Opening Communication Port



Opening Communication Port

If you want to connect your computer to another computer in the same room
or you want the other computer to dial in to your computer, then you must 
first open a communication port. You do this by making an entry in the 
phonebook. Follow same steps as you do when you add a new entry to the 
phonebook but leave the phone number field in the communication settings 
dialog box as empty. Click on the dial button. Your communication channel 
would open up.

Related topics:

Adding a new entry
Phonebook summary
Chat Mode



Baud 
The number of bits transferred per second.



Phonebook Summary

Here is a brief summary of all the buttons in the phonebook:

Cancel
Removes the phonebook from the display.
Dial
Dials the selected entry.
New
Adds a new entry in the phonebook.
Delete
Deletes a selected entry from the phonebook.
Copy
Copies an existing entry to a new entry with a new name and a phone 
number.
Autologin
Executes the script file for the selected entry.
Options
You select a timeout period for a connection. You can also specify a retry dial 
count here.
 



Settings
 
Note: All settings excepting that of color and scroll back buffer apply locally 
to a given service.

Communication Setting
Modem Setting
Terminal Emulation
Color
Keyboard
Fonts
Default Directory
Protocol



Communication Setting
 
Communication settings dialog box can be invoked from the phonebook's 
edit button. This command allows you to define your communication 
parameters. Here is a list of options available to you:

Cancel
Removes the box from display
Name
Enter your service name (max 8 characters).
Phone number
The phone number of remote computer.
Phone prefix
This field is required for an internal phone system to connect to an outside 
line or to wait for a dialtone. This usually is 9.
Baud Rate
Select the    speed of your modem. The most common setting is 2400 baud.
Data Bits
Specify the number of data bits in each data packet exchanged between 
yours and the remote computer. This field usually is either 8 or 7.
Parity
Select the type of parity. Select no parity for 8 data bits and an even/odd 
parity for 7 data bits.
Port
Here you specify your communication port where you have your modem 
connected. This usually is either 1 or 2.
Flow Control
This selection specifies which action is to be taken when the incoming data 
buffer gets full. Select hardware flow control for half duplex connections and 
Xon/Xoff flow for full duplex communication. As most communications are full
duplex, select Xon/Xoff flow control.



Modem Setting
This option can either be selected from communication settings dialog box or
from the settings menu. You select your modem by clicking on your modem 
type in the list box and then selecting OK.    If    you do not find your modem 
in the listbox then select a custom modem option. You can modify the 
preexisting initialization, dial, hangup, escape and reset strings by retyping 
them. You can also edit the result codes if    your modem returns them in a 
different form. This must only be done in case you are having problems with 
the communication. Consult your modem manufacturers documentation for 
details. 



Terminal Emulation
 
Wintel can emulate most of the popular terminal types. Perhaps the most 
popular    terminal emulation used in the industry is VT100(ANSI). You select 
terminal preference either from the communication settings dialog box or 
from the settings menu. In VT100 and VT52 mode, your function keys F1 to 
F4 behave like those of DEC's PF1 to PF4. Keep the Num Lock key down to 
emulate the DEC VT100 keypad. Codes sent by numeric keypad 9 to . are 
same as those sent by DEC's VT100 terminal. The PCs insert key sends the 
same code as sent by keypad s enter key on a VT100 terminal. To emulate 
BBSs graphic characters, choose the terminal fonts from the fonts menu 
option.

Wintel also has a raw terminal emulation mode. This allows you to view all 
the characters sent by the remote computer. These include control keys. This
feature is extremely useful in examining    the raw codes sent by the remote 
computer. 

Following options may also be selected:

Local Echo
This option is useful when the remote computer does not echo your typed in 
characters. This is the case when the remote computer operates in an half 
duplex mode. Do not make this selection as most computers operate in full 
duplex mode.
CR->CR/LF
Specifying this option enables carriage return and a line feed to be sent to 
the remote computer when you press an enter key . As most computers send
you a linefeed, do not    select this option.
Buffer Lines
Here you specify the number of lines this program should save. The default is
200 lines. You may save upto 200 lines in the buffer for later viewing.
Terminal Width
Here you specify width of the terminal. The default is 80 columns.
Auto Wrap
Here you specify whether or not text wraps to next line when it reaches right 
margin. The
default setting is auto wrap as most of the BBSes assume.
OK
Clicking on OK will save your settings.
Cancel
Cancel will cancel all the changes you have made to the terminal prefs dialog
box.



Keyboard
When you select this option from the Settings menu, a keyboard dialog box 
appears. You can examine keycode sent to the remote computer by clicking 
on the desired key. Here you can also define function keys F5 to F12 for your 
purposes. Function keys F1 to F4 have already been assigned to the DEC's 
VT100 and VT52 control codes. You make an assignment to the function key 
by clicking on say F5. Another window will appear. You can type in your string
here. Remember to type "Enter" key as ^M. Similarly all control keys are 
prefixed by a caret ^. For example if you want to define F5 as a control-Z 
then enter ^Z in the edit box. If you want the definition to contain a escape 
character (ASCII 27) then enter ^[. 



Color
You can select color settings for the text and the window background by 
selecting color command from the settings menu for terminals other than 
VT100 (ANSI Color) terminal. For ANSI Color terminal, by default, white text is
shown on the black background. Select the element and then choose the 
desired color from 16 predefined VGA colors. If these colors do not suit your 
needs then create your own colors with the help of three RGB scroll bars. By 
changing the red, green and the blue component    of a color, any desired 
color can be achieved. Once you have made your choice,    save them by 
clicking the OK button. You may revert back to your original window colors by
clicking on the default button.



Fonts
You can select font command from the settings menu. A list of all the fixed 
size fonts are shown in listbox. A font is selected by clicking on the desired 
entry in the listbox. Font size need not be selected as this program adjusts 
the size of the font based on your window size.



Default Directory
Here you specify the default directory for the file transfer and your session 
logs. If    the session log option is enabled then the log file would be stored in 
the directory you specify in the session log edit box. Your downloaded files 
from the remote system will go to the directory specified in the default 
download directory edit box.



Protocol
You select the file transfer protocol by selecting the protocol command from 
settings menu.

If you are transferring ASCII files and you have an error correcting modem 
then you may opt for the ASCII protocol. However, as there is no error 
checking done in this protocol, this protocol is very unreliable.    ASCII file 
transfer has other options. Click on the option button. Most systems require 
you to send a character to initiate the file transfer. This usually is a "return". 
Type in ^M if the remote system requests you to send a carriage return for 
downloading ASCII file. Some systems send a control character as an end of 
file transfer. This usually is control T. Type in ^T in the EOF character edit 
box.

For binary transfers, the most reliable protocol is that of ZMODEM. ZMODEM 
protocol has other options too. If    you want crash recovery option enabled 
then check on this button. Crash recovery is done in the following manner. If 
the requested file date is same as that of a file previously transferred and the
file size is greater than that of    the existing files. Then the recovery is 
possible. There are two other options in the ZMODEM protocol. One is the file
skip option. If    you already have a file with the same name and of the same 
date then this system will request the remote system to skip sending this 
file. The other is segmented streaming option. If    you are experiencing 
problems while receiving files with the default option of full streaming then 
select this option. This would slow down your file transfer considerably.
 

Related topics:

Description of Protocols



Protocol
Protocol is a set of rules which define how computers can communicate.



File Transfer and Protocols

Once you have established a connection to the remote system. You can 
exchange text and binary files. In order to transfer files, you must first select 
a protocol which both your system and the remote system recognize. A text 
file is a file created by a text editor known as an ASCII file. A binary file is a 
file of any kind. This could be a bitmap image or an executable file. It is 
recommended that you use binary file transfer protocol for all your file 
transfers. This is due to the fact that    ASCII file transfer protocol does not do 
any error checking. For binary transfers, you may opt for one of the protocols
described below:

XMODEM/Checksum
This protocol transfers data in 128 byte packets. It does error checking of the
data with checksum. It is reliable but is slow because of the small packet 
size. Also it does not have a batch transfer capability.

XMODEM/CRC
This protocol transfers data in 128 byte packets. It does error checking of the
data with 16 bit CRC. It is reliable but is slow because of the small packet    
size. Also it does not have a batch transfer capability.

XMODEM (1K)
This protocol transfers data in 128 and 1024 byte packets. It is an extension 
of XMODEM/CRC. This protocol    is also known    incorrectly as YMODEM. This 
is not a batch protocol therefore only one file can be transferred per transfer.

YMODEM(BATCH)
Like XMODEM(1K), this protocol transfers data in 128 and 1024 bytes data 
blocks but in its first block it sends the filename, filesize and the file creation 
date. This protocol is fast, reliable and has a batch transfer capability.

YMODEM(BATCH -g )
Like XMODEM(1K), this protocol transfers data in 128 and 1024 bytes data 
blocks but in its first block it sends the filename, filesize and the file creation 
date. This protocol does not have intermediate acks and naks. Therefore it is 
more suited for the hardwired connection. This protocol is extremely fast but 
not recommended because a single error would cause the retransmission of 
the entire file. This protocol has a batch transfer capability.

ZMODEM
This is perhaps the most popular protocol today. It is fast because it can do 
full streaming, very reliable and allows batch file transfers. Also it allows the 
transfer of partial files (known as crash recovery) in case    transfer was 
aborted. 



Related topics:

Receiving Files
Sending Files



Receiving Files

If    you want to receive files using ASCII, XMODEM or YMODEM Batch 
protocol. You choose receive command from the File transfer menu. This 
must be done after the remote system has informed you that it is ready to 
send you the files. Once you have selected the receive command, you will be
asked for a filename of the downloaded file in case of ASCII and XMODEM (All
flavors) protocol.

If you have opted for YMODEM batch protocol, no such dialog box appears as
the filename is contained in first block of the data packet.

For ZMODEM, do not choose receive file command from the menu.This 
program will automatically detect the transfer once the downloading starts.

Once the file transfer starts, you will see a window with the statistics such as 
file name, total number of bytes to receive, number of bytes received etc. 
You may abort the transfer anytime by clicking on the Cancel button.



Sending Files
First you inform the remote system that you wish to upload files.As for the 
receiving files, you select the protocol which matches with the remote 
system. If you need to send multiple files choose YMODEM Batch or ZMODEM
protocol. A dialog box would appear asking you for the name of files which 
you wish to transfer. For batch operation, you may review the file list to be 
uploaded and make more additions or deletions. Once you are done, click on 
the done button. Another window would appear which shows you the file 
transfer statistics. If    you wish to abort the transfer then simply click on the 
Cancel button. Once your transfer is complete, you will see a message to this
effect in the transfer window. Click on the OK button to remove the transfer 
window from the screen. 



Utilities
Following utilities/options are available:

Viewing GIF/JPEG File
uuencode
uudecode



Viewing GIF/JPEG File
 
If you want to view a GIF/JPEG file while downloading it, enable the view 
GIF/JPEG realtime option from the utilities menu. Any file of type GIF/JPEG 
would be displayed on a separate window while being downloaded. 

You can also view stored GIF/JPEG files by selecting view GIF/JPEG offline 
command from the utilities menu. This would activate a WinGif task. By 
choosing "Open" from the file menu in WinGif and selecting file of type 
GIF/JPEG, the file can be viewed. You can resize the picture by selecting 
stretch/shrink command in the File menu. You exit the GIF/JPEG viewer by 
choosing "Exit" command from the file menu.



UUENCODE
uuencode utility allows you to encode a binary file to an ASCII file so that it 
can be transmitted on Usenet or send as an email on an internet. When you 
select this option,    You will be asked for the file name to encode. Select the 
file and your file be encoded with the extension uue. If your input file is of 
large size then the output file is split over into multiple files with sequence 
numbers appended to the file name. The first line of    encoded file contains 
begin 600 filename and the last line has an end. 



UUDECODE
 
uudecode utility allows you to decode uuencoded file. Generally on an 
internet, a uuencoded file is transmitted in a batch because of its large size 
i.e. file a.uue may be transmitted as a1.uue and a2.uue. When you select 
this option, you will be asked for the file names which need to be uudecoded.
Once you have selected your files, press on the done button and your file will
be decoded. Make sure that each of the files contain a begin at the start of 
the decoded text and an end at the end of the decoded text.
 



Scripts 
Script is a file which would automate your login session.

Related topics:

Editing Scripts
Executing Scripts



Editing Scripts
Use Edit command in the script menu to call the notepad editor to edit a 
script file. Here is an example of a script file to connect to delphi service via 
a local sprintnet number: 

All comments in the script file begin with !.

!
! connect to delphi
! define timeout for waitstring command. The default is 10 seconds. You may 
place this 
! timeout anywhere before waitstring command.
timeout 5 
!
! Transmit string in quotation to remote
send    "@D"
! Wait for string "terminal" from the remote computer
waitstring    "terminal: "
! once it finds string "terminal" it sends a carriage return
send    "^M"
! transmit "c delphi"
send    "c delphi"
! wait for string "username:" from remote"
waitstring "username:"
! Send the username "jjohn"
send "jjohn"
! waits for string "password:" from remote
waitstring "password:"
! sends password "abcdef"
send "abcdef"
! exit from script
exit



Executing Script
Once you have created a script file and you have made an entry of the 
service in the phonebook, you can execute it either from the command 
execute in the Script menu or by clicking on the Autolog button in the 
phonebook.



Edit
Following commands are available:

Copy and Paste
Clearing Scroll Buffer



Copy and Paste
If you want to send the text from the clipboard, first copy the text to the 
clipboard. This can be done either from some other application or from your 
own screen. You select the text to be copied to the clipboard by pressing on 
the left mouse button and dragging over the text you want copied. Once the 
text is selected, choose copy command from the edit menu. Your text will be 
copied to the clipboard. Next choose the transmit command from the edit 
menu. Your text will be transmitted. 



Clearing Scroll Buffer
When you receive text from the remote computer, this text is placed in a 
buffer which can be viewed by using vertical scroll bar. If you want to clear 
this buffer, use the clear buffer command from the Edit menu.



Printing
You can print your session log file by selecting print logfile command from 
the File menu. You will be asked for the file name to be printed. Select the 
desired file and your file would be printed. You can also print the saved scroll 
back    buffer by selecting print buffer command from the File menu.

Related topic:

Session Capture



Session Capture
Select session capture command from the session menu. You can direct all 
your incoming data from the remote system onto to a file for later viewing 
and printing. Your session log file name would be the name of the online 
service you are    connected to with log extension. You can stop capturing the
session by reselecting the capture session command from the session menu.

Related topic:

Printing



Chat Mode
With this option you can chat with the user logged onto a remote computer.   
When you make this selection, your window will split into two halves. The 
upper window will display the text you type in and the bottom window would 
show you the response from the remote user. Before you can commence 
chatting, you must first establish a connection.    This can be done either your
dialing    in to his/her system or wait for a call from the other end. If the other 
end wants to dial in to your system, you must first open your communication
port. Use the phonebook, make an entry with no phone number and click on 
the    dial button. This would open up the communication channel. From the 
option menu enable the "Answer " command and then wait for the call. 
However, If this option is disabled, then any incoming call would result in a 
"RING" text on your screen. You type in "ATA" and the connection would be 
established. Enable the chat mode if you have not already done so. Now you 
are ready to chat.    Disconnect the connection by choosing "Hangup" 
command from the "Dial" menu.



Disconnecting

If you want to disconnect from a session, you must first hangup. This is done 
by selecting "Hangup" command from the session menu. You may then 
either exit from the program or dialin to another service. You exit the 
program by selecting Exit command from the File menu.



How to Register
Wintel 1.5 Registration

NOTE: If you are registering through CompuServe , then at the GO prompt 
type SWREG and    follow their instructions for registration. The registration ID
of Wintel is #2863. 

For all others, please fill out this order form:

Item Price

Wintel 1.5 Disk ( 3.5 ___ or    5.25 ___) 
with manual $39.95
Shipping and Handling $ 5.0 ( U.S. & Canada )

$ 10.0 ( Foreign ) 
Tennessee residents, please add 8.25 % sales tax $ 3.25
________________________________________________________________

Total Amount _______
________________________________________________________________

Name ____________________________________________________

Address 1 ____________________________________________________

Address 2 ____________________________________________________

City ______________________          State________      ZIP___________

Country ____________________________________________________

Phone ( ) ____________- ________________________________

Signature: ____________________

Online service where you downloaded Wintel from: _______________________

Please mail this form with your Check/Money Order (payable to Satyavrat 
Mehrotra):

Satyavrat Mehrotra
SMSOFT
1345 Oak Ridge Turnpike, Suite # 287
Oak Ridge, TN 37830



Please allow 2 - 3 weeks for delivery.



Miscellaneous Commands
Check Modem Port
This command checks for the port where your modem is connected. 

Comm Status
This command in the Misc. menu displays the communication status. If the 
system is hung because it received a bad XOFF character, then you would 
see the box next    to transmission is waiting as a result of    xoff character 
being received    as checked. You can clear this box by clicking on it. This 
makes the system think that it has received a required xon character.
 
Break
By enabling this option from the Misc. menu, you would suspend character 
transmission and place the communication device in the break state. When 
you enable this option, a checkmark would appear next to the break 
command. You disable this option by reselecting the break command. The 
character transmission would resume.

Dial Sequentially
By enabling this option from the Misc. menu, you tell the system to dial    
online services in a sequential manner till the connection is established.




